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Capitulo 1: Importar OMF/AAF

Cuando un proyecto viene desde Premiere, Final Cut, Media Composer u otro sistema de edicion
de video, normalmente no recibes una sesion de Pro Tools. Recibes un intercambio: OMF o AAF.
Ese archivo describe clips, posiciones, nombres de pistas y referencias a medios para reconstruir el
timeline de audio dentro de Pro Tools.

Video: https://www.youtube.com/embed/LemI7WI6KI0

Objetivo del capitulo

Importar una edicion de audio desde un NLE y verificar que el material quede sincronizado,

completo y listo para organizar.

OMF y AAF

« OMF (Open Media Framework) es un formato antiguo pero todavia comun para intercambio de
audio.
« AAF (Advanced Authoring Format) es mas moderno y suele conservar mejor metadatos, automa-

tizacion y estructura.

En posproduccion conviene pedir AAF cuando sea posible, especialmente si el proyecto tiene

muchas pistas, muchos clips o una organizacion compleja.

Antes de importar

Confirma estos datos con la persona de edicion:

+ Frame rate del proyecto: 23.976, 24, 25, 29.97 o 30 fps.

« Sample rate: normalmente 48 kHz para audiovisual.

 Duracion y timecode de inicio.

+ Silos medios vienen embebidos en el AAF/OMF o en una carpeta aparte.

« Si existe video de referencia con burn-in de timecode.

Riesgo comun

Si el frame rate de la sesion no coincide con el proyecto de video, los clips pueden parecer

correctos al inicio y desfasarse mas adelante. Revisa esto antes de editar.

Procedimiento

1. Crea una sesion nueva de Pro Tools con el sample rate correcto.


https://www.youtube.com/embed/LemI7WI6KI0
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Configura el frame rate de la sesion antes de importar.

Ve a File -> Import -> Session Data.

Selecciona el archivo OMF o AAF.

Decide si vas a copiar los medios a la carpeta de la sesion o referenciarlos desde su ubicacion

Al S

original.

=

Importa las pistas necesarias.
7. Reproduce varios puntos del timeline contra el video de referencia.

Que revisar despues

» Que todos los clips aparezcan en posicion.

+ Que no existan archivos offline.

+ Que los nombres de pista sean comprensibles.

+ Que el primer evento importante coincida con el timecode del video.

+ Que los canales mono/stereo tengan sentido.

Practica

Importa un AAF u OMF de prueba y crea una lista de verificacion con tres puntos de sincronizacion:
inicio, mitad y final. Si los tres coinciden con el video, la importacion es confiable para empezar a

editar.
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Capitulo 2: Preferencias Importantes

Antes de editar conviene ajustar Pro Tools para trabajar con seguridad. Algunas preferencias
afectan directamente la sincronizacion, la respuesta de edicion y la forma en que se guardan los

cambios.

Video: https://www.youtube.com/embed/Ut3KAeYsRZ4

Objetivo del capitulo

Configurar una base de trabajo para posproduccion que reduzca errores y haga mas rapidala edicion

diaria.

Como entrar a preferencias

« Mac: Pro Tools -> Preferences
« Windows: Setup -> Preferences

No todas las versiones de Pro Tools muestran exactamente los mismos nombres, pero la logica

general se mantiene.

Preferencias clave

Operation

« Timeline Insertion Follows Playback: decide si el cursor queda donde se detuvo la reproduc-
cion. Es util cuando quieres revisar y corregir de inmediato el ultimo punto escuchado.

« Auto Backup: activa copias automaticas de la sesion. Para trabajo de clase o edicion intensa, 5
minutos es un buen punto de partida.

+ Open Ended Record Allocation: limita el tiempo maximo de grabacion si el sistema lo permite,

para evitar archivos innecesariamente grandes.

Editing

« Levels of Undo: aumenta el historial de deshacer. En edicion de dialogo y clips pequenos, un
valor bajo se queda corto muy rapido.

 Clip Auto-Fade In/Out: ayuda a evitar clicks en cortes, aunque no reemplaza una edicion fina.

» Separate Clip Operates On All Related Takes: revisa esta preferencia si trabajas con playlists

o tomas relacionadas.


https://www.youtube.com/embed/Ut3KAeYsRZ4
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Mixing

« Default Track Color Coding: ayuda a reconocer familias de pistas. En sesiones grandes, el color
es informacion operativa.

+ Send and Insert behavior: revisa si necesitas que los nuevos envios o inserts sigan una

convencion del estudio.

Recomendacion para posproduccion

Usa Timecode como referencia principal cuando trabajes contra video. Si el proyecto viene de cine
o animacion, puede ser necesario activar Feet+Frames, pero para la mayoria de flujos audiovisuales

actuales el timecode sera la referencia mas clara.

Habito recomendado

Antes de empezar una sesion importante, abre preferencias y confirma Auto Backup, niveles
de Undo, frame rate y visualizacion de ruler. Dos minutos de revision pueden evitar una tarde

de reparacion.

Practica

Abre una sesion de prueba y configura Auto Backup cada 5 minutos. Haz tres cambios, guarda una
copia manual y ubica la carpeta de backups. El objetivo es saber donde recuperar una version si

algo sale mal.



Pro Tools para Posproducciéon Sonora Victor Herrera

Capitulo 3: Ventana de Edicion

La ventana de edicion es el centro del trabajo en Pro Tools. Aqui se organizan pistas, clips,
selecciones, rulers, grupos y herramientas. Entender su distribucion permite moverse mas rapido

y cometer menos errores.

Barra de Herramientas

e Tiempo (Reglas)

Pistas|(Tracks)

Figura 1: Vista general de la ventana de edicion de Pro Tools
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Modos de Edicién

Ajusta automaticamente el
espacio al mover.

Mueve regiones sin afectar
otras.

Coloca regiones en tiempos
precisos.

Alinea regiones con una
cuadricula de tiempo.

Figura 2: Track List y zonas principales de la ventana de edicion

Herramientas de Edicién

Seleccidn se utiliza para seleccionar
regiones o clips de audio en la linea de
tiempo para su edicién o
manipulacién.

Grab se utiliza para mover
regiones o clips de audio en
la linea de tiempo.

Trim permite ajustar
rapidamente la duracién de
una region o clip

El "scrubber" permite
desplazarse por la linea de
tiempo reproduciendo el
audio en tiempo real.

Zoom Permite acercar o alejar
la vista en la linea de tiempo.

La herramienta Smart Tool combina
varias funciones de edicién en una sola:
Trim, Selection y Grab

Lapiz permite realizar ajustes precisos
en la forma de onda de audio
directamente en la linea de tiempo.

Figura 3: Timeline, rulers y herramientas de edicion
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Edicién por capas en Pro Tools permite

" _y trabajar con varias regiones de audio
Herramientas de Edicion superpuestas y editarlas de forma

Zoom de la seleccién. independiente.

Al presionar |a tecla "Tab", el cursor se
desplaza automaticamente hacia la
siguiente transiente en la pista
seleccionada.

La edicién MIDI reflejada, o "mirrored
MIDI editing" permite editar una pista
MIDI y aplicar automaticamente esos
cambios a una pista MIDI duplicada o
reflejada.

La funcién "markers follow edit"
asegura que los marcadores de
tiempo en una sesion se ajusten
automaticamente cuando se realizan
ediciones en la linea de tiempo.

La funcién "Link Timeline and Edit
Selection" permite sincronizar la

seleccion en la linea de tiempo con la
seleccion en la ventana de edicion.

La funcién "Automation Follows Edit"
permite que los cambios realizados en la
edicién de audio, como cortar, copiar o
pegar, se reflejen automédticamente en los
datos de automatizacion de esa pista.

La funcién "Link Track and Edit

Selection" permite sincronizar la
seleccion de pistas en el mezclador
con la seleccion en la ventana de

La funcién "Insertion Follows Playback" te
permite automéaticamente posicionar el
cursor de insercion (o punto de inicio para

grabar o editar) al final de la reproduccion.

edicion.

Figura 4: Clip List y flujo de trabajo dentro de la ventana de edicion

Objetivo del capitulo

Reconocer las zonas principales de la ventana de edicion y entender para que sirve cada una durante

una sesion de posproduccion.

Zonas principales

Track List

La lista de tracks aparece al lado izquierdo. Sirve para mostrar, ocultar, seleccionar y reorganizar

pistas. En sesiones grandes es una herramienta de navegacion, no solo una lista.

Timeline

Es el area central donde se ven y editan clips de audio, video, MIDI y automatizacion. La mayoria

de decisiones de sincronizacion ocurren aqui.

Clip List
Contiene los clips disponibles en la sesion. Puede servir para recuperar material, buscar archivos

importados o revisar si quedaron clips sin usar.

Rulers

Los rulers muestran referencias de tiempo: Timecode, Minutos:Segundos, Bars|Beats, Samples o

Feet+Frames. Para audiovisual, Timecode suele ser el ruler principal.
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Herramientas de edicion

Herramienta Atajo Uso principal
Zoomer F5 Acercar o alejar una zona del timeline
Trimmer F6 Ajustar inicio o fin de un clip
Selector F7 Seleccionar rangos de tiempo
Grabber F8 Mover clips
Scrubber F9 Escuchar mientras desplazas el cursor
Pencil F10 Dibujar automatizacion o reparar muestras
Smart Tool  F6 + F7 Combinar Trimmer, Selector y Grabber
Smart Tool

El Smart Tool cambia de funcion segun la zona del clip donde colocas el cursor. En la parte superior
puede hacer fades; en los bordes funciona como Trimmer; en el centro permite seleccionar o mover.

Es una de las herramientas mas usadas porque reduce cambios de modo.

Lectura visual

Antes de tocar un clip, mira que herramienta esta activa, que pista esta seleccionada y que

ruler estas usando. Muchos errores no vienen de falta de conocimiento sino de editar en el

modo equivocado.

Practica

Crea una sesion con tres pistas de audio. Activa cada herramienta con F5 a F10 y realiza una accion

simple: zoom, trim, seleccion, movimiento y scrub. Repite lo mismo con Smart Tool.
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Capitulo 4: Seleccionar Tracks

Seleccionar tracks parece una operacion simple, pero en sesiones de posproduccion puede marcar
la diferencia entre editar con control o afectar material que no querias tocar.

Seleccionar Pistas(Tracks)

ESC-001-A-004_A051_C | i E£5C-001-A-

7)-3.5d8

£8C.1| | E¢] | [E8C-001-8-00

ESC-001-A-004_AOS1_C004_0325XB_001.R3D.mov-

Para seleccionar o de seleccionar un track: COMMAND-CLICK (Mac) 6 CTRL-CLICK (Windows) sobre el nombre del track.
Para seleccionar o de seleccionar un todos los tracks: OPTION-CLICK (Mac) 6 ALT-CLICK (Windows) sobre el nombre de un
track.

Y con Shift realizamos selecciones de tracks contiguos.

Figura 5: Seleccion de tracks en Pro Tools

Objetivo del capitulo

Seleccionar una o varias pistas de forma precisa para aplicar acciones colectivas: mover, ocultar,
borrar, colorear, rutear, mutear o solear.

Metodos de seleccion

Seleccion simple

Haz clic en el nombre del track en el panel izquierdo. Esta seleccion afecta a la pista completa, no
necesariamente a los clips del timeline.

Seleccion multiple contigua

Haz clic en el primer track, luego Shift + clic en el ultimo. Pro Tools selecciona todas las pistas
entre ambos puntos. Es ideal para bloques como dialogos, ambientes o efectos.
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Seleccion multiple no contigua

Usa Cmd + clic en Mac o Ctrl + clic en Windows sobre cada track. Sirve cuando quieres seleccionar

pistas separadas sin alterar las que estan entre ellas.

Seleccionar todos los tracks

Usa Edit -> Select All, Cmd + A en Mac o Ctrl + A en Windows. Antes de hacerlo, confirma que
la accion siguiente realmente debe aplicarse a toda la sesion.

Para que sirve seleccionar tracks

« Mutear o solear una familia completa de pistas.

« Asignar color a tracks del mismo tipo.

« Mover grupos de pistas para reorganizar la sesion.
» Cambiar entradas, salidas o buses en varias pistas.

« Ocultar material temporalmente sin borrarlo.

Criterio de organizacion

Una convencion simple puede ser:

Familia  Prefijo Color sugerido

Dialogos DX Verde
Foley FOL Amarillo
Efectos SFX Azul
Ambientes AMB Cian
Musica MUS Rojo
Auxiliares  AUX Morado

Consejo

Selecciona por familias antes de editar. Si necesitas trabajar dialogos, deja claro visualmente

donde empieza y termina ese bloque de pistas.

Error comun

Confundir seleccionar un track con seleccionar clips. Una pista puede estar seleccionada, pero eso
no significa que todos sus clips esten seleccionados en el timeline. Antes de borrar o mover, mira

si la seleccion esta en la cabecera de pista, en los clips o en un rango de tiempo.

Practica

Crea seis tracks y nombrarlos como DX_1, DX_2 SFX_1, SFX_2 6 AMB_1 y MUS_1 . Practica

seleccion contigua, no contigua y seleccion total. Luego asigna colores por familia.

10
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Capitulo 5: Agregando Tracks

Crear tracks no es solo aumentar espacio en la sesion. Cada track tiene tipo, formato, timebase,

nombre y funcion dentro del flujo de mezcla o edicion.

Video: https://www.youtube.com/embed/QbEqmpN0otg

Agregando Tracks

El Shortcut para agregar tracks es: COMMAND+SHIFT+N
(Mac) 6 CTRL+SHIFT+N (Windows)

Figura 6: Atajo para agregar tracks en Pro Tools

Objetivo del capitulo

Crear pistas nuevas con el tipo correcto para cada necesidad de posproduccion.

Atajo para agregar tracks

e Mac: Command + Shift + N
* Windows: Ctrl + Shift + N

El dialogo permite crear una o varias pistas al mismo tiempo. Tambien puedes definir si seran mono,

stereo, 5.1, 7.1 u otro formato disponible.

11
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Tipos de tracks

Victor Herrera

Tipo Uso en posproduccion
Audio Track Clips de audio: dialogos, efectos, foley, ambien-
tes
Aux Input Buses, retornos de reverb, subgrupos, procesa-
mientos compartidos
Master Fader Control del nivel de una salida o bus
VCA Master Control grupal de faders sin procesar audio
directamente
Video Track Video de referencia dentro de la sesion

Instrument Track

Configuracion al crear tracks

Revisa estos campos antes de aceptar:

Count: cantidad de tracks.

Type: tipo de track.

Format: mono, stereo, surround, etc.
Timebase: Samples o Ticks.

Name: nombre inicial del track.

Timebase

Instrumentos virtuales, menos comun en edi-

cion audiovisual

Para posproduccion usa normalmente Samples. Los tracks basados en Ticks siguen el tempo

musical y pueden moverse si cambia el mapa de tempo. En trabajo contra imagen, eso puede

romper sincronizacion.

Ejemplos practicos

o Para editar dialogos: crea varios Audio Tracks mono.

« Para ambientes stereo: crea Audio Tracks stereo.

« Para enviar dialogos a una reverb comun: crea un Aux Input stereo.

« Para controlar un grupo de dialogos: usa un VCA Master si tu version de Pro Tools lo permite.

Practica

Crea una plantilla minima con:

4 tracks mono para dialogo.

2 tracks mono para foley.

2 tracks stereo para ambientes.
2 tracks stereo para efectos.

1 aux stereo para reverb.

12
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Nombralos antes de empezar a importar clips.

13
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Capitulo 6: Eliminando Tracks

Eliminar tracks es una accion sencilla pero riesgosa. En Pro Tools, una pista puede contener clips,
automatizacion, playlists, inserts, envios y ruteos. Borrarla sin revisar puede eliminar informacion
util.

Video: https://www.youtube.com/embed/WeAucqso_7Q

» Macintosh HD:Users:victorherrera:Nextcloud:Clase:
HD:L

HD:L i | :Clases:01)

Eliminando Tracks

HD:Users:vi Clases:01)
HD:L

HD:L lase:

HD:L lase:

HD:L

h HD: U 1

HD:L Jase

Cuando eliminamos tracks, el audio 6

el MIDI clip se mantendra en la D e o Cmer
sesion y los podemos encontrar en el e e
Clip List foemmme

(2240222000000 0000000000000 000000000000 000000001
®

HD:Users:vi X :.Clases:01,
1

Figura 7: Clip List después de eliminar tracks en Pro Tools

Objetivo del capitulo

Distinguir cuando conviene eliminar un track y cuando es mejor ocultarlo o desactivarlo.

Como eliminar tracks

1. Selecciona el track o los tracks desde la cabecera.
2. Revisa si contienen clips, automatizacion o playlists.
3. Usa Track -> Delete o clic derecho sobre el track y Delete.

4. Confirma solo si estas seguro.

14
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Advertencia

Eliminar un track borra su contenido dentro de la sesion. En algunas situaciones no es una
accion que puedas resolver limpiamente con Undo. Guarda una copia de la sesion antes de

limpiar material importante.

Eliminar vs ocultar

Accion Que ocurre Cuando usarla
Ocultar La pista sigue existiendo, pero Cuando quieres limpiar la vis-
no se ve ta sin perder nada
Desactivar Reduce carga o deja una pista Cuando tal vez la necesites
fuera de uso temporal despues
Eliminar La pista desaparece de la se- Cuando ya verificaste que no
sion sirve

Checklist antes de borrar

« La pista no tiene clips necesarios.

« No contiene automatizacion importante.

« No tiene playlists alternativas utiles.

+ No alimenta un bus o envio que todavia se usa.

» Hay una copia reciente de la sesion.

Practica

Crea tres tracks con clips de prueba. Oculta uno, desactiva otro y elimina el tercero. Luego intenta
recuperar la organizacion original desde una copia o backup para entender la diferencia entre cada

accion.

15
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Capitulo 7: Nombrando Tracks

Nombrar tracks es parte de la comunicacion profesional de una sesion. Un buen nombre permite
entender rapidamente que contiene una pista, a que familia pertenece y como debe tratarse en

edicion o mezcla.

Video: https://www.youtube.com/embed/eEfE9hCqqJE

Objetivo del capitulo

Crear nombres consistentes para que la sesion sea legible para ti y para cualquier persona que la

reciba.

Como renombrar un track

1. Haz doble clic sobre el nombre del track.
2. Escribe el nuevo nombre.
3. Presiona Enter para confirmar.

4. Usa Tab para pasar rapidamente al siguiente nombre cuando estes renombrando varios tracks.

Convenciones utiles

Tipo Ejemplos
Dialogos DX_1, DX_2, DX_BG, DX_ALT
Efectos SEX_1, SEX_IMPACT , SFX_DOOR
Foley FOL_STEPS , FOL_CLOTH, FOL_PROPS
Ambientes AMB_CITY , AMB_ROOM , AMB_FOREST
Musica MUS_SCORE , MUS_SOURCE , MUS_TEMP

Auxiliares  AUX_DX_REV , AUX_SFX_VERB , AUX_PRINT

Buenas practicas

« Usa prefijos cortos y repetibles.

* Evita nombres ambiguos como Audio 1 o New Track.
« Mantén el idioma consistente.

« Ordena pistas por familia.

« Siel estudio entrega una especificacion tecnica, usa esa convencion antes que la tuya.

16
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Entrega profesional

Una sesion ordenada comunica cuidado tecnico. Antes de entregar, revisa nombres de tracks,

colores, ruteos y pistas vacias.

Practica

Toma una sesion con tracks sin nombre y renombrala con una convencion clara. Luego pide a otra

persona que identifique donde estan dialogos, foley, ambientes y musica sin reproducir la sesion.

17
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Capitulo 8: Mover Clips

Mover clips es una de las acciones mas frecuentes en edicion de sonido. Tambien es una de las mas

delicadas: un pequeno desplazamiento accidental puede romper la sincronizacion con imagen.

Video: https://www.youtube.com/embed/h81sn4wP5rE

Objetivo del capitulo

Mover clips en el timeline con control horizontal, vertical y temporal.

Herramientas para mover
Puedes mover clips con:

« Grabber Tool (F8): selecciona y arrastra clips.
« Smart Tool: permite mover cuando el cursor esta en la zona adecuada del clip.

» Nudge: mueve en incrementos definidos sin usar el mouse.

Movimiento libre
Con Grabber o Smart Tool, arrastra el clip a una nueva posicion. Observa dos cosas:

« Si cambia de tiempo, se mueve horizontalmente.

« Si cambia de track, se mueve verticalmente.

En posproduccion, muchos movimientos deben conservar el track o conservar el tiempo. Por eso

los modificadores son importantes.

Modificadores de movimiento

Accion Mac Windows
Restringir movimiento hori- Ctrl + arrastrar Ctrl + arrastrar
zontal
Copiar clip Opt + arrastrar Alt + arrastrar
Copiar y restringir horizontal Ctrl + Opt + arrastrar Ctrl + Alt + arrastrar

18
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Consejo
Si solo quieres cambiar la posicion temporal de un clip sin cambiarlo de track, usa el modifi-
cador de restriccion horizontal. Es una forma simple de evitar errores en sesiones con muchas

pistas.

Nudge

Nudge mueve clips en incrementos exactos. Es ideal para sincronizar pasos, golpes, respiraciones

o efectos puntuales.

1. Define el valor en Nudge Value.
2. Selecciona el clip.
3. Usa * o - del teclado numerico para avanzar o retroceder.

Valores comunes:

« 1 frame para sincronizacion fina con imagen.
« 5 frames para ajustes medianos.

+ 10 frames o mas para desplazamientos rapidos.

Error comun

Mover un clip mientras el grid o el modo de edicion no corresponde al trabajo. Antes de ajustar

sincronizacion fina, revisa si estas en Slip, Grid, Shuffle o Spot.

Practica

Importa un clip corto contra video. Haz tres copias: una sincronizada, una adelantada 1 frame y una
atrasada 1 frame. Escucha y observa la diferencia. El objetivo es entrenar la percepcion de pequefios

desfases.
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Capitulo 9: Zoom Horizontal

El zoom horizontal controla cuanto tiempo ves en la ventana de edicion. No cambia el audio ni la

posicion de los clips; cambia tu escala de trabajo.

Video: https://www.youtube.com/embed/JIMBwbLwxRA

Objetivo del capitulo

Usar el zoom horizontal para alternar entre vista general, revision de escena y edicion de detalle.

Atajos de zoom horizontal

Accion Atajo
Zoom In T
Zoom Out R

Zoom a la seleccion  Opt + F (Mac)/ Alt + F (Windows)

Ver toda la sesion Opt + A (Mac)/ Alt + A (Windows)

Los atajos R y T dependen del modo de comandos de teclado. Si no funcionan, revisa si el foco

de comandos esta activo.

Tres escalas utiles

Vista de sesion

Sirve para ubicar estructura completa: escenas, bloques, canciones, cortes o reels.

Vista de escena

Permite editar con contexto. Ves suficiente material antes y despues del punto de trabajo.

Vista de detalle

Se usa para ajustar respiraciones, clicks, transientes o sincronizacion frame a frame.

Zoom presets
Pro Tools permite guardar presets de zoom. Una estrategia practica:

« Preset 1: vista amplia de la sesion.
+ Preset 2: escena completa.
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« Preset 3: dialogo cercano.
+ Preset 4: detalle de clip.
« Preset 5: revision ultra fina.

Consejo

No edites todo al mismo nivel de zoom. Alejate para tomar decisiones de estructura y acercate

solo cuando necesites precision.

Practica

Coloca tres markers en una sesion. Navega entre ellos y cambia entre vista general, vista de escena
y vista de detalle. Repite hasta que puedas hacerlo sin perder orientacion.
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Capitulo 10: Zoom Forma de Onda

El zoom de forma de onda controla el tamarfio visual de la onda dentro del clip. No modifica el
volumen, clip gain, automatizacion ni nivel real del audio.

Video: https://www.youtube.com/embed/mmtWZ0eHK9U

Objetivo del capitulo

Usar el zoom vertical de waveform para editar con mas claridad sin confundir visualizacion con

nivel de audio.

Para que sirve

« Ver sefiales grabadas a bajo nivel.
« Identificar respiraciones, transientes, golpes o clicks.
» Comparar visualmente clips cercanos.

+ Ajustar cortes en zonas de cruce por cero o baja energia.

Atajos en Mac

Accion Atajo
Ampliar onda Opt + Cmd + ]
Reducir onda Opt + Cmd + [

Restaurar zoom por defecto  Ctrl + Opt + Cmd + [
En Windows los modificadores pueden variar segun teclado y version. La idea es distinguir siempre

entre zoom vertical de waveform y ganancia real.

No cambia el audio

Si una onda se ve grande por zoom vertical, no necesariamente suena mas fuerte. Para cambiar

nivel usa clip gain, fader, automatizacion o procesamiento.
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Cuando usarlo

Dialogo bajo
Amplia la onda para encontrar ataques de palabras, respiraciones y cortes. Esto ayuda a limpiar
dialogo sin depender solo del oido.

Foley y efectos

Los transientes cortos pueden verse mejor con zoom vertical. Es util para alinear pasos, golpes

0 props.

Revision visual

Despues de editar, reduce el zoom para no tomar decisiones de nivel basadas en una visualizacion

exagerada.

Practica

Toma un clip de dialogo bajo. Amplia la forma de onda, corta una respiracion y luego vuelve al

zoom normal. Verifica que el nivel no cambio.
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Capitulo 11: Markers

Los markers son puntos de referencia en el timeline. En posproduccion permiten navegar por

escenas, cambios de seccion, notas de revision, golpes importantes y puntos de sincronizacion.

Video: https://www.youtube.com/embed/T-zI1fkbiGU

Objetivo del capitulo

Crear y usar markers como sistema de orientacion dentro de sesiones largas.

Que son los markers

Un marker guarda una posicion en el timeline. En Pro Tools forma parte del sistema de Memory
Locations, que puede guardar mas informacion que un simple punto temporal.

Los markers sirven para:

» Marcar inicio de escenas.

« Senalar cambios de acto o bloque.

+ Ubicar problemas pendientes.

« Saltar rapidamente entre puntos de revision.

« Coordinar notas con direccion, edicion o mezcla.

Crear un marker

El atajo principal es Enter del teclado numerico. No es lo mismo que el Enter principal del teclado.
Tambien puedes crear markers desde:

« Marker ruler -> clic derecho -> Add Marker
« Event -> Memory Locations -> Add

Memory Locations
Una Memory Location puede guardar:

« Posicion de timeline.
« Estado de zoom.

« Seleccion.

« Pre-roll y post-roll.

« Visibilidad de tracks.
« Estado de grupos.
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Para uso basico, piensa en ellas como marcadores. Para sesiones avanzadas, pueden funcionar como

vistas guardadas de trabajo.

Navegar entre markers

Accion Atajo

Ir al marker N .N. en teclado numerico
Siguiente marker  Opt + ] (Mac)/ Alt + 1 (Windows)
Marker anterior ~ Opt + [ (Mac)/ Alt + [ (Windows)

Convencion de nombres

Usa nombres claros y escaneables:
e ESC_01 Inicio

e ESC 02 Puerta

 REV ruido dialogo

« FIX falta ambiente

» SYNC golpe mesa

Consejo

En proyectos de cine, crea un marker al inicio de cada escena. Eso transforma la sesion en un

mapa navegable y reduce la dependencia de memoria visual.

Practica

Importa un video corto y crea markers para tres escenas o cambios visuales. Luego navega usando
1., .2., .3. desde el teclado numerico. El objetivo es moverte sin arrastrar manualmente el

Cursor.
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